Pivot Table Examples (EXCEL 2007)

Pivot Tables are an Excel 2007 feature that all IT financial personnel should learn how to use because it is an easy tool that can be used to summarize data in spreadsheets. Instead of analyzing rows or records, a pivot table can aggregate the data to help facilitate overall business analysis. The following examples will show you how to create summary tables and review financial activity using UMREPORTS data.

Example #1: Reviewing ICR generated year to date by DeptID, PI, and Project

Log into UM Reports (www.umreports.umn.edu) and search for the word “recovery.”

1) Select the report called “F&A Recovery.”

<table>
<thead>
<tr>
<th>Category:</th>
<th>SubCategory:</th>
</tr>
</thead>
<tbody>
<tr>
<td>F&amp;A Recovery</td>
<td>Enterprise Financials</td>
</tr>
</tbody>
</table>

Include on my Home Page: F&A Recovery
(no description)
**TIP:** Once report is included on your Home Page, it will show up automatically when you log onto UMREPORTS.

2) For starting accounting period, select 2009-2010, period 1, click “Submit.”

Prompt Selection for F&A Recovery Report

Select a Fiscal Year, Accounting Period to Report From:

To view a range of accounting periods within a fiscal year, use this selection for the starting fiscal year and accounting period.

Fiscal Year 2009-2010 Accounting Period 1

Submit Reset
3) For accounting period through, select 2009-2010, and the latest accounting period available in the dropdown box, click “Submit.”

**Prompt Selection for F&A Recovery Report**

2010-1

Select a Fiscal Year, Accounting Period to Report Through:

Fiscal Year 2009-2010 Accounting Period 7

Submit Reset

At this point, you could limit the report by project or PI, but since the point of this exercise is to demonstrate pivot tables, we will not do this. Also note, with rare exception, all ICR comes into the college in DeptID 11055, so if you limit the report to your own DeptIDs you will get no results.

4) Click the button by “Select by RRC, ZDeptid, Deptid” and select “ITXXX” from the dropdown. Click on “Submit.”

**Prompt Selection for F&A Recovery Report**

2010-1 → 2010-7

- View Report with these Selections
- Select by RRC, ZDeptid, Deptid
  - Enter a RRC
  - Enter a ZDeptid
  - Enter a Department
  - Enter a PI Empid
  - Enter a COI Empid
  - Enter a Project ID

Select RRC below:

**ITXXX - Institute of Technology**

Submit Reset
5) Click on “View Report with these Selections.”

Prompt Selection for F&A Recovery Report

2010-1 – 2010-7 – ITXXX

- View Report with these Selections
- Select a ZDepartment

Click on a link for View Report below:

6) Click on the Excel icon on the top right of the screen (if this errors-out, click on the CSV icon) and open the file. Even if you use CSV, it should open in Excel.

7) In Excel, delete the top 7 rows, so the column headings are row 1 of the worksheet, and delete the rows after the last row of data.
Also delete the “Fund Code,” “Program,” and “CS” columns, because they add no value – every row is 1026-UM003 with no CS. (Short cut: Select column, right click & delete it.)

8) Make the CF1 column (now column B) wider. The DeptID responsible for generating the ICR is coded in this column.
9) Select all of the data in column B, but not the heading. Click on the “Data” menu, and click on “Text to Columns” (about in the middle of the screen).

10) Click on the “Fixed width” button and click “Next.”
11) Click in the word “DPTIDXXXXX” so that a vertical line is displayed between “DPTID” and the DeptID number. Click “Next.”

![Diagram 1](image1.png)

12) Click on the “Do not import column” button. Click “Finish.” “DPTID” should disappear from every cell in column B.

![Diagram 2](image2.png)
13) Re-label column B as “Responsible DeptID.” Now you have a clean data table on which to base the pivot table.

Voila!

14) Select all the cells with your data including the column headings.
15) Click on the “Insert” menu, and select the furthest left option, “PivotTable.” Click “OK.” A new worksheet will be inserted with a pivot table based on the data you selected.

SUCCESS!
Note: In testing this method, some users have encountered errors with this step. If you get a “Data Source Reference Not Valid” error, copy & paste data into another spreadsheet. Click on A1, Insert, Pivot Table & proceed with step #16.

Using the pivot table:

16) In the right pane, Drag “Responsible DeptID” down to the “Report Filter” box. A dropdown will appear in the spreadsheet.

17) Drag “Amount” to the “Values” box. Click on “Sum of Amount,” and choose “Value Field Settings.” Verify that Excel is summing Amount and not counting.
18) Click on “Number Format” and choose currency with no decimal places.

Currency formats are used for general monetary values. Use Accounting formats to align decimal points in a column.
19) Use the dropdown in cell B1 to see the ICR generated by an individual DeptID or a combination of DeptIDs by using the “Select Multiple Items” box.

20) To view information on all DeptIDs, drag “Responsible DeptID” in the right panel from the “Report Filter” box to the “Row Labels” box.
21) To get the details for a DeptID, put “Responsible DeptID” back into the “Report Filter” box, and limit the report to one DeptID in which you know there is activity.

22) Drag “Project” into the “Row Labels” box. (Note: the zeros may have been dropped from the start of the Project numbers.)
23) Drag “PI/CO Name” to the “Row Labels” box. First put it before “Project” in the box. Then, move it to after “Project” to see how the report changes based on the order of the fields.

Pivot Tables allow us to “drag and drop” data to produce meaningful information. Remember: You are not changing the structure of the original table, just manipulating the information to produce the desired results.
Example #2: Reviewing year-to-date non-sponsored activity

1) Log into UM Reports and select the report: Chartfield String Budget Status for Current Non-Sponsored Funds.

![UM Reports](image)

New Reports (10 since last viewed)

- All Funds Reports
- Budget UM Reports
- Class Lists
- Class Permission Reports
- Enrollment/Course Reports
- FOAA Reports
- Executive Reports
- Financial Aid
- Grade Reports
- HR Reports
- ICR Reports
- Instructor Activity Reports
- Non-Sponsored Reports
  - Account Budget Status for Current Non-Sponsored Funds
  - Account Detail for Non-Sponsored Funds
  - Account Summary for Non-Sponsored Funds
  - Account Transactions for Non-Sponsored Funds
  - Chartfield String Budget Status for Current Non-Sponsored Funds
  - College Account Summary for Non-Sponsored Funds
  - Department Account Summary for Non-Sponsored Funds
  - JV Detail for Student Financials

2) Choose 2009-2010 and the latest accounting period available in the dropdown.

Prompt Selection for Chartfield String Budget Status for Current Non-Sponsored Funds Report

Select a Fiscal Year, Accounting Period to Report Through:

- Fiscal Year: 2009-2010
- Accounting Period: 7

Submit Reset
3) Enter the DeptIDs you are interested in, separated by a comma (no spaces). Click “Submit.”

Prompt Selection for Chartfield String Budget Status for Current Non-Sponsored Funds Report

2010-7

- Enter a DeptID
- Select an RRC, DeptID
- Enter a Fund
- Enter a Program
- Enter a CotyProject
- Enter a FinEmpId
- Enter a CF1
- Enter a CF2

Enter DeptID below:

Output for the report can be filtered on A
CF1, or CF2.

You may also enter (blank) values for the
values for Fund, Deptid, and Program an

Multiple values can also be entered and

11101,11102,11103,1110

Submit  Reset

4) Click the button by “Enter a Fund” and limit it to 1000,1026,1701,1750. Click “Submit.”

Enter Fund Code below:

Output for the report can be filtered on A
CF1, or CF2.

You may also enter (blank) values for the
values for Fund, Deptid, and Program an

Multiple values can also be entered and

1000,1026,1701,1750

Submit  Reset
5) Click “View Report with these selections.”

6) Try to export to Excel by clicking the Excel icon on the top right of the screen. If the file is too large, try the CSV icon.

7) In Excel, delete the top 9 rows, so the row with the column names is row 1.

At the bottom, delete the rows after the last row of data.
8) Insert a new worksheet. (If you can’t see the worksheet tabs, it is because your horizontal scroll bar is sized so it hides the tabs. Grab the bottom left of the horizontal scroll bar and drag it to the right to make it smaller.)

If you see this:

Move the bar to the right like this:

Tip: Right click on UMReports tab in bottom left corner of spreadsheet and “insert” new worksheet.

**FYI---Tab default might be labeled “Sheet 1”**

9) With cell A2 of the new worksheet selected, go under the “Insert” menu and choose “PivotTable” (on the far left).
10) Click on the top box with the small red arrow in it, and select the data in your other sheet, including the header row. After selecting the data, click on the small box with the arrow pointing down, then click “OK.”

**FYI---Tab default might be labeled “Sheet 1”**
SUCCESS!

If you are not successful and see a “data source reference not valid” error, copy & paste data into separate worksheet. Click on cell A1, click insert, pivot table and “okay”. Proceed to next step.

Using the pivot table: This pivot table contains a large amount of data that can be manipulated in numerous ways. Below are just a couple examples of how you could use the pivot table to quickly do basic financial analysis.

Remember: If it is not what you expect, just UNDO and try again. You will do no harm!

12) Drag “Prior Yr CFWD” to the “Values” box.
13) It may have defaulted to Count (it takes a guess). Click on “Count of Prior Yr CFWD” and choose “Value Field Settings.”

Change this to “Sum” and Click on “Number Format,”
14) Change it to currency with no decimal places. Click “OK.” It is now displaying the total carryforward (into FY10) in all the DeptIDs you ran the UM Report on.

Now you are ready to summarize the account activity. Simply “drag & drop” the fields you wish to analyze into the appropriate areas below.

Please proceed to steps 15-22 and complete the analysis. Not sure what to click? Please refer to previous screen shots.
15) To see how the carryforward was spread across the DeptIDs, drag the word “DeptID” from the top left corner of the spreadsheet and drop it on the word “Total” in the pivot table. To see how it was spread across funds, drag the words “Fund Code” down until you see a vertical gray line in the pivot table, then drop it. You should now see the carryforward split by DeptID and then by Fund (or vice versa depending on where you dropped Fund Code).

16) To see how the prior year carryforward compares to the current balance, in the right pane, drag the word “Balance” and drop it in the “Values” box under “Sum of Prior…”

17) Click on “Balance” and choose “Value Field Settings.” Confirm it is summing and change the number format to currency with no decimals.

18) If you want to limit the report to certain programs, choose the “Program Code” dropdown and choose one (or multiple) programs.

19) Drag all of the fields in the four boxes on the right pane back up to the field list to clear the pivot table.


21) Drag “Prior Yr CFWD,” “Actual Adjusted Revenue,” “Actual Net Expenditures,” “Actual Transfers In,” “Actual Transfers Out,” “Total Encumbrances,” and “Balance” into the “Values” box (in that order). Change any of them that are counting to “Sum” and format the numbers to currency with no decimals for all fields.

Your actual year-to-date activity is now showing across the columns, starting with the carryforward into the year and ending with the current balance (including encumbrances).

22) To view individual chartstrings, use the dropdown filters at the top of the pivot table, or drag the dropdown boxes and drop them in the pivot table. This can also be accomplished by dragging the field names in the right pane into the “Row Labels” box.

Practice: Try to create a pivot table that shows Budgeted Expenditures vs. Actual Expenditures in funds 1000 and 1026 for one of your DeptIDs.

Good Luck! ☺️